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EU-DECLARATION OF CONFORMITY 

We, SKF Maintenance Products, 

Kelvinbaan 16, 3439 MT NIEUWEGEIN, The Netherlands, 

declare that 

Thermal Imager TMTI 300 

has been designed and manufactured in accordance with: 

EMC DIRECTIVE 89/336/EEC as outlined in harmonised norm for 

Emission EN 50081-1, EN 55011 (B) 

Immunity EN 50082-2, EN 61000-4-2, -3, level 3. 

USA FDA Standard 21 CFR, Ch 1, Part 1040.10 

and is provided with the European CE approval. 

The Netherlands, June 2005 

Ebbe Malmstedt 

Manager Product Development and Quality 
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SAFETY RECOMMENDATIONS FOR TMTI 300 

Always read and follow the operating instructions. 

Do not expose the equipment to rough handling or heavy impacts. 

The equipment must not be used in areas where there is a risk for explosion. 

Never aim the laser beam into someone’s eyes. 

Use of controls or adjustments or performance of procedures other than specified in these 

instructions may result in hazardous laser radiation exposure. 

Opening the housing of the measuring unit may result in hazardous laser radiation 

exposure and voids warranty. 

Do not expose the equipment to high humidity or direct contact with water. 

All repair work should be taken care of by an SKF repair shop. 
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1 Getting Started  

This User Manual refers to the SKF Thermal Imager system type TMTI 300, for use with a ‘Pocket 

PC’,or a PC. 

1.1 Contents 

The tool case contains the following items; 

TMTI 300 Thermal Imager 

Battery holder with 4 x AA (LR6) alkaline batteries. 

12 V mains adapter with 4 plug inserts. 

RS 232 Connection cable for PC 

Handle for one handed use of imager and iPaq. 

Cable for use between recommended HP iPaq's and TMTI 300 

CD ROM with software and instructions for use. 

Inspect all items before use. Damaged items must not be used. 

1.1.1 TMTI 300 Thermal Imager parts 

Figure 1. Thermal imager parts 

1. On/Off switch and Power LED 

2. Laser pointer aperture 

3. Lens 

4. DC power socket 

5. Laser pointer button. 

6. RS 232 socket 

7. Battery compartment 

1

2

3
4
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1.2 Connecting To Power 

The TMTI 300 Thermal Imager operates from 4 x AA (LR6) alkaline batteries, or from AC mains power.   

1.2.1 Using Battery Power 
1. Turn the Thermal Imager off.   

2. Slide battery cover off. 

3. Carefully remove battery holder and insert batteries. Standard AA (LR6) alkaline batteries or 

rechargeable batteries can be used. The polarity of the batteries is shown on the holder. 

4. Replace battery holder. Check the connector is positioned towards the centre of the imager. 

5. Replace battery cover.  

Do not use a 9V (6LR61) battery.

NOTE:

4 new alkaline batteries last approximately 8 hours. 

If the red power LED starts flashing, immediately replace the batteries.  

1.2.2 Using Mains Power Adapter 

1. Turn the Thermal Imager off. 

2. Connect the DC power socket. 

3. Attach the appropriate plug insert to the mains adapter. 

4. Plug the power supply into a mains socket.  

5. Switch on thermal imager. 

CAUTION: When using AC mains, only use the power supply included with the TMTI 300. 

Other power supplies may damage the TMTI 300 Thermal Imager. 

NOTE:

It is recommended that the SKF Thermal Imager (not the ‘Pocket PC’) should be switched on approximately 2 

minutes before use.  This allows the internal electronics to stabilise, to achieve optimum performance. 

The mains adapter is only for powering the TMTI 300. It will not recharge the batteries. 

Fig 2. Inserting batteries 
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1.3 Connecting the TMTI 300 to a ‘Pocket PC’  

1. Make sure the TMTI 300 Thermal Imager software has been installed onto the ‘Pocket PC, see 

Section 3.3.1.1

2. Connect the Pocket PC’s RS232 serial synchronization cable into its socket and the other end 

into the TMTI 300 RS232 socket, see Figure 3.

Figure 3: The TMTI 300 Thermal Imager connected to a ‘Pocket PC’, configured for two handed 

operation

NOTE: The pocket PC must be purchased separately. 
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2 One Hand operation 

2.1 TMTI 300 Handle 

The TMTI 300 Handle allows one-handed operation of the unit. The imager is attached to the front of 

the handle. A ‘Pocket PC’ is securely fixed to the back. The handle is designed to accept most commonly 

used ‘Pocket PC’ models. 

The serial synchronization cable can be concealed within the handle grip. 

2.1.1 Mounting the imager and Pocket PC onto the Handle. 

The pictures below give a step-by-step guide on mounting the TMTI 300 imager and a ‘Pocket PC’ onto 

the handle. 

                                                 

1. Front view 

2. Back view 

   

1)  Gently squeeze the handle grips and open the handle 

             

1 2 



Page 9 MP 5317E   

2) Un-clip and remove the cable connector cover.       

     

3) Connect the serial synchronization cable to the 'Pocket PC' 

and thread the other end of the cable from through the back 

of the handle. 

                

4) Pull the cable though the handle then mount the 'Pocket 

PC' on the back of the handle. pull the spring loaded clip up to 

secure the 'Pocket PC".  

     

5) NOTE:  The clip can be rotated to accommodate different 

Pocket PC models. The clip must not foul the On/OFF button.
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6) Replace and Slide the cable cover into position 

    

7) Remove the RS232 connector cover from the thermal 

imager. Connect the free end of the cable. Replace the cover 

8) Line up the holes on the back of the imager with the pegs 

on the handle. 

       

9) Push the imager down onto the pegs, so that it locks down 

into position.  
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10) Coil the cable and store in the handle. Close the handle 

grip.  

      

11)This makes using the imager very simple for many 

applications! 

2.1.2  Removing the Imager from the Handle. 

2

3

1
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3 Operating the TMTI 300 Thermal Imager 

Described in this section are:  

The Hardware 

Using the Laser Pointer 

Using the TMTI 300 Thermal Imager with a ‘Pocket PC’ 

Using the TMTI 300 Thermal Imager with a PC 

3.1  Computer Hardware 

The TMTI 300 system is designed for use with a ‘Pocket PC’ or a PC.  For use with a ‘Pocket PC’ the 

imager is connected via an RS232 serial synchronization cable. The standard cable for use with most 

iPaq's is included (see 3.3.2.4).   

For a PC, use the RS232 serial cable included. 

The TMTI 300 Thermal Imager can be connected to a ‘Pocket PC’ via an RS232 serial 

synchronization cable, see Section 1.3.

To use the TMTI 300 with an IBM compatible PC, the supplied RS232 serial cable is inserted 

into the socket on the bottom of the imager. The other end connects into a COM port on the 

PC.  Operation with a PC is independent of the ‘Pocket PC’.  

3.2 Using the Laser Pointer 

The Laser pointer is used to allow the operator to illuminate and identify the centre of the scene that 

the Thermal Imager is viewing. 

The laser pointer illuminates the area of the scene that is viewed by the “default” temperature 

measurement pixel. This is the central point on the ‘Pocket PC’ display, which is indicated by a red circle 

in Figures 4.

The length of the laser bar gives an indication of the pixel dimension. For the TMTI 300 to give an 

accurate temperature reading, the minimum area of the scene being viewed must be a square that 

totally encloses the laser bar. Therefore, the laser pointer is a useful tool to determine the maximum 

viewing range of the TMTI 300.   

3.3 Using the TMTI 300 Thermal Imager with a ‘Pocket PC’ 

Most ‘Pocket PCs’ can be used with the TMTI 300 Thermal Imager.  This section describes some of the 

basic functions of ‘Pocket PCs’ with the TMTI 300. These functions are common to many different 

available brands of ‘Pocket PC’s.   
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3.3.1 Setting up the ‘Pocket PC’ with the TMTI 300 Thermal Imager 

3.3.1.1 Installing the SKF TMTI 300 Imager software onto a ‘Pocket PC’ 

The TMTI 300 Thermal Imager can be used with most ‘Pocket PCs’, which have an RS232 serial port 

and run Microsoft ‘Pocket PC’ 2000, 2002, 2003 or MSWM 5, see Section 3.3.2.4 for recommended 

‘Pocket PC’s.  The ‘Pocket PC’ can be used to display, process and store snapshots of thermal images. 

1. Ensure that ActiveSync is installed on your PC from the CD supplied with your Pocket PC, and 

that it is communicating with your ‘Pocket PC.’ 

2. Refer to your ‘Pocket PC’ User Manual for more information on ActiveSync and synchronising 

your ‘Pocket PC’ with a PC. It is not necessary to create an ActiveSync synchronized partnership 

between the two. If you are given the option to choose between a “standard” and a “guest” 

partnership, select “guest”. 

Note: If you have difficulty connecting, go into the ActiveSync connection settings dialog screen 

and “check” both the ‘allow serial’ and ‘allow USB’ connection boxes.  

3. Make sure the ‘Pocket PC’ is switched on, and connected to the PC. 

4. Insert the supplied SKF TMTI 300 Imager software CD Rom into your PC’s CD-Rom Drive.  

5. On the PC screen, double click on ‘My Computer’ and then on the ‘CD-Drive (D:)’. 

6. On the PC screen, double click on the folder “CE Install” 

7. On the PC screen, double click on ‘TMTI 300 CE setup.exe’ to start the installation. 

8. Follow the on-screen prompts, to complete the installation. 

NOTE:

While the Thermal Imager may be used solely with the ‘Pocket PC’, access to a PC is necessary for 

installing the Thermal Imager’s software to the 'Pocket PC’. 

If the ‘Pocket PC’ has Flash memory or a memory card, the SKF ‘Pocket PC’ software will 

automatically be saved onto this memory during the initial installation. 

As an alternative to the portable use of the TMTI 300 using a ‘Pocket PC’, the output of the imager 

can be displayed and processed in real time using a PC, see Section 3.4 for using the TMTI 300 

with a PC.

3.3.1.2 Starting the SKF TMTI 300 Imager software 

1. Check that the ‘Pocket PC’ is charged. 

2. Make sure the ‘Pocket PC’ is connected to the TMTI 300 Thermal Imager with an RS232 serial 

synchronization cable.  This cable is either supplied with the ‘Pocket PC’ as a standard item or 

can be ordered from the ‘Pocket PC’ supplier as an accessory. A cable suitable for use with 

most iPaq's is included. 

3. Switch on the ‘Pocket PC’ and the Thermal Imager.  

4. Using the Stylus pen from the ‘Pocket PC’, select the Start menu and then select the Programs

folder. Select the icon labelled “SKF TMTI 300 Imager”.

5. Operation of the TMTI 300 Imager application is by means of the Navigation/Action button and 

software buttons.  See Sections 3.3.2.2 for further information.   

NOTE:

The SKF Imager program takes a few seconds to load.
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If the ‘Pocket PC’ battery is allowed to fully discharge, the imager software will be lost and must be 

re-installed either from memory storage or from the CD again.  The ‘Pocket PC’ uses power even 

when it is switched off.  Regular recharging and transferral of images is therefore recommended.   

3.3.1.3 Reinstalling the SKF TMTI 300 Imager software onto a ‘Pocket PC’ from Flash Memory. 

3.3.2 Operating the ‘Pocket PC’ with the TMTI 300 Thermal Imager 

Figure 4: Screenshot of SKF TMTI 300 Imager ‘Pocket PC’ Software 

1. Default Laser Pixel 

2. Temperature cursor and temperature reading 

3. Temperature range 

4. Selected temperature range 

5. Temperature difference between two selected temperature cursors. 

6. Pocket PC battery indicator.

NOTE:

For optimum performance the imager should be switched ‘ON’ and allowed to settle for about 2 minutes. 

If the ‘Pocket PC’ locks up then perform a soft reset of the ‘Pocket PC’. Refer to your ‘Pocket PC’ User Manual 

for more information on Resets.   

6

4

3

5

1

The imager software can be re-installed from flash
memory storage on newer Pocket PC’s using File 
Explorer.  For example on HP iPAQs, open “File 
Explorer”, first select “My Device” from the drop 

down menu at the top of the screen, then select 
“iPAQ File Store” and finally “TMTI 300 Imager”. 
Select “OK” to confirm re-installation. 

2
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3.3.2.1 Software Button Operations 

Figure 5: Buttons used within the SKF TMTI 300 Imager software. 

1. Grab - takes a snapshot of the image 

2. Auto - automatically adjusts temperature range and sensitivity 

3. Tools - Allows the user to set a number of parameters (eg. Emissivity) 

4. Browse - Allows the user to browse and delete saved snapshots 

5. Exit - Closes down the SKF TMTI 300 Imager software 

Grab

Takes a snapshot of the currently displayed image.   

The user is asked ‘Do you wish to save this image?’,  

Select ‘Yes’ or ‘No’. ‘ 

No’ will discard the snapshot and return to ‘Live’ mode.    

‘Yes’ will save the image with the name ‘Snapshot n.snp’, where n is the next available number 

in the sequence starting from 1. 

NOTE:   

All the setting and cursor functions may be applied to the grabbed image frames. 

Go to ‘Browse’ to view saved snapshots. 

Auto

The Auto button can be set in the ‘Tools’ section to operate in two different modes: 

4

1

5
32

“Ticked box” Continuous Auto - Continuously adjusts the temperature range

and sensitivity of the image for ease of viewing.   In this mode the ‘Auto’ button

can be used to switch Continuous Auto on or off. 

 “Unticked box” Continuous Auto - The ‘Auto’ button is used in a one shot mode

i.e. each time the button is pushed it will automatically adjust the temperature

range and sensitivity for the present scene. 

With Continuous Auto off, the image can be adjusted in a manual mode using 

the Nav/Action button, see Section 3.3.2.2 for more information. 
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Tools

Gives access to the following settings:  

Figure 6: Tools menu within the SKF TMTI 300 Imager software. 

1. Image Label – The user can enter a name for saved snapshots. 

2. Image Folder – Defines the  path directory to which snapshot images are saved . 

3. Ambient (
o
C) – Sets the ambient temperature; if the emissivity (see below) is not given the 

value of 1 the software compensates for the ambient temperature to give more accurate 

temperature readings. Limited to 200ºC if value entered is above 200ºC. 

4. Emissivity – Selects the emissivity for the material being imaged.  Setting the correct emissivity 

value is important to achieve the accuracy of temperature readings, see note 3 in Section 4.1. 

5. Calibration– Calibration file information. 

6. Colour Map– Selects one of three possible colour options: 

a. Greyscale 

b. Red-Blue 

c. Green-Blue 

7. Interpolate – Selects a displayed resolution, of 16x16 pixels or 96x96 pixels.  

8. 2
nd

 Element – The user can select whether to have the second (SP2) temperature cursor 

displayed on the screen. see Figure 4. 

9. Continuous Auto – See section on ‘Auto’ above for further explanation. 

10. Integration – The number of image frames to be integrated can be set to ‘Integration OFF’ or 

up to 10 frames. This function reduces “noise” on the image; it should be turned off when 

imaging a moving scene. 

11. Temp. Units  – Selects the temperature units displayed: 

a. Celsius (
o
C) 

b. Fahrenheit (
o
F)

c. Kelvin (K) 

1

2

3

4

5

6

7

8

9

10

11
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Browse

Gives access to five other buttons: 

Prev – Loads the previous snapshot file. 

Next – Loads the next snapshot file.   

Delete – Deletes the current snapshot.  Dialogue box appears with, ‘Are you sure? Yes/No’.  

Tools – Returns to the ‘Tools’ Menu, (see Tools above). 

Live – Returns to Live imaging mode. 

Exit 

Shuts down the SKF TMTI 300 Imager software application. 

3.3.2.2 Navigation/Action Button Operations 

All ‘Pocket PCs’ have a central Navigation/Action button.  This is the only physical button used for 

operating the SKF TMTI 300 Imager software.   

The Navigation/Action button can be depressed at five points and has five primary functions -  

U - up, D - down, L -left, R - right, S- select.

Figure 7:  The Navigation/Action button of an HP iPAQ 5000 Series ‘Pocket PC’

With ‘Auto’ adjust toggled OFF, pressing the centre S of the Navigation/Action button cycles through 

three options.  The selected option is indicated by a flashing red outline surrounding the box.  The three 

options are: 

1. Manual control of the sensitivity and temperature range bar.  This can be used in snapshot 

mode, or when ‘Auto’ adjust is toggled OFF.  

The Sensitivity and temperature range of the displayed image can be manually adjusted by 

use of the Navigation/Action button.  Pressing U or D adjusts the sensitivity and pressing L 

or R adjusts the temperature range. 

2. Selected Temperature Cursor (SP1). 

The SP1 cursor can be moved around the screen on the thermal image by using the 

Navigation/Action button, i.e. U, D, L, R.  

3. Selected Temperature cursor (SP2). 

The SP2 cursor can be moved around the screen on the thermal image by using the 

Navigation/Action button, i.e. U, D, L, R. 

D

U

RL

S
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When the ‘Auto’ adjust is toggled ON, pressing the Nav/Action button will cycle between the two 

temperature cursors, and not the manual control bar. 

3.3.2.3 Snapshot Transfer from a ‘Pocket PC’ to a PC 

Microsoft ActiveSync must be installed to transfer Snapshot images from the ‘Pocket PC’ to a PC.  Refer 

to your ‘Pocket PCs’ User Manual for more information on Microsoft ActiveSync.   

To transfer a Snapshot file from the ‘Pocket PC’ to the PC, use this procedure: 

1. Ensure that ActiveSync is installed on your PC and communicating with your ‘Pocket PC.’ 

2. Refer to your ‘Pocket PC’ User Manual for more information on ActiveSync and synchronising 

your ‘Pocket PC’ with a PC. 

3. On the PC, from the File menu in ActiveSync select “Explore”. This will open a “Mobile Device” 

window.  If the folder appears to be empty, select “Refresh” from the View menu 

4. Double click on “My Pocket PC”.

5. Double click on “My Documents” then select Snapshots, or click on the folder in which the 

snapshots have been saved. The folder in which snapshots are saved can be selected on the 

‘Pocket PC’; see Tools in Section 3.3.2.1.  The snapshots will have extensions “.snp”

6. Copy the required Snapshots to a suitable folder on the PC (click and drag; or right click-copy 

then right click-paste into the folder). 

NOTE:

It is advisable to periodically download saved Snapshot images from the ‘Pocket PC’ to a PC.  If a ‘Pocket PC’ 

battery runs flat, all saved images on the ‘Pocket PC’ will be lost, unless they are saved into Flash memory or 

onto a memory card (e.g. an SD card). 

3.3.2.4 Recommended ‘Pocket PCs’ for use with the TMTI 300 

This table is the current SKF view on ‘Pocket PCs’ which have been tested with the TMTI 300, as of 

March 2005.  For an up to date list of recommended ‘Pocket PC’s, please see the SKF Mapro website, 

www.mapro.skf.com.

‘Pocket PC’ Synchronizing cable  

HP RZ1710 
Autosync Cable. 

HP part number FA122A 

HP iPAQ hx2000 series 
Autosync Cable. 

HP part number FA122A 

HP iPAQ H5100 & H5500 series 
Autosync Cable. 

HP part number FA122A 

HP iPAQ H4150 series 
Autosync Cable. 

HP FA122A#AC3 

HP iPAQ rx3700 series 
Autosync Cable. 

HP part number FA122A 

HP iPAQ hx 4700 series 
Autosync Cable. 

HP part number FA122A 

HP H2210 
Autosync Cable. 

HP part number FA122A 
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It is necessary to acquire the appropriate synchronization cable for a specific ‘Pocket PC’.  For more 

information on synchronization cables it is advisable to contact your local manufacturer (e.g. HP) or 

supplier. A cable suitable for the HP "Pocket PC's" listed above is included with the TMTI 300. 

3.4 Using the TMTI 300 Thermal Imager with a PC  

The PC should be IBM compatible running MS Windows XP or 2000, with an RS232 serial port, USB 

port and 24 bit colour graphics.  If a laptop PC is used, a TFT display is recommended.  This application 

can be used for online imaging with the TMTI 300 connected to the PC or for analysis of snapshots 

previously saved on a ‘Pocket PC’.   

3.4.1 Installation of software on PC 

The software is on the supplied CD-Rom. 

1. Insert the supplied CD-Rom into the PC’s CD-Drive (D:).   

2. Double click on ‘My Computer’ and then on the ‘CD-Drive (D:)’. 

3. Double click on the “PC Install” folder. 

4. Double click on ‘TMTI 300 PC Setup.exe’. 

5. Follow the on screen prompts to complete the installation. 

NOTE:

The SKF TMTI 300 Imager software will by default be installed into the following path:

C:\Program Files\SKF\SKF TMTI 300 Imager 

The above path and name can be changed during the installation, but it is advisable to leave it as the default.  

The installation will also put a ‘Shortcut Icon’ onto your PCs desktop to allow quick and easy start-up of the 

software. 

3.4.2 Operating SKF TMTI 300 Imager software 

Connect the Thermal Imager to the PC using the RS232 cable provided. 

Launch the SKF TMTI 300 Imager program from the Desktop icon, or from:  

START/PROGRAMS/SKF/SKF TMTI 300 Imager 

When launched, the window obtained will be similar to Figure 8.

On initial launch, if the Thermal Imager is not connected or switched on, the message “NO INCOMING 

DATA” will appear in the status box.  The image window will contain the last viewed image, and the 

temperature displayed will be from the last viewed image. 

On connecting the Thermal Imager to the PC and switching it on, the program will make connection 

with the imager (this may take several seconds).   

On some PC’s, after connecting the imager, it may be necessary to close the SKF TMTI 300 Imager 

application, and then reopen it. This allows the program to detect the COM port that the imager is 

using.  The status box contains information on the settings of the imager, and the co-ordinates of the 

selected cursor whose temperature output is displayed in the temperature window. 
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3.4.2.1 Turning off Microsoft ActiveSync: 

A common problem when communicating with the Thermal Imager is that the Microsoft ActiveSync 

program has “taken over” the available COM port.  This may be rectified as follows: 

1. Open the ActiveSync program (either by the Icon at the bottom right of the PC screen or from 

the Desktop). 

2. From the File menu select “Connection Settings”.

3.  “Un-check” the “Allow serial cable or infrared connection to this COM port” box, if already 

checked.  If not required, the Ethernet box should be “Un-checked”. 

4. ‘OK’ the Connection Settings window, and ‘Close’ the ActiveSync window. 

5. Remember to “re-check” the serial cable connection box after use, if it is needed for other 

applications.  

3.4.2.2 Control Panel 

The Controls in the control panel are as follows: 

Sensitivity – see below for explanation. 

Range – see below for explanation. 

Resolution – sets the level of interpolation from 16 X 16 up to 128 X 128. 

Colour map – sets the display in greyscale, red-blue or blue-green. 

Orientation – the image can be rotated around to different orientations. 

Temperature Graph time scale – sets the temperature graph range. 

Ambient – set the ambient temperature. 

Emissivity – select a value to suit the object under examination, see Note 3 in Section 4.1.

Calibration Set – The calibration file is displayed in this box. 

Temperature units – choose 
o
Celsius, 

o
Fahrenheit or Kelvin. 

Integration – sets the number of frames to integrate, up to ten maximum. 

Figure 8: Thermal Imager launch window 

1

2

3

4

5



Page 21 MP 5317E   

1. Temperature display window 

2. Selected temperature range 

3. Status box 

4. Laser default pixel 

5. Image window 

Adjusting the displayed Thermal Image: 

The sensitivity and range can be automatically adjusted for a single image by clicking on the 

‘Single Auto Gain’ button.  For continuous automatic adjustment the ‘Continuous Auto Gain’ 

button should be selected, this button is on the tool bar, see Figure 9.

To use the manual controls whilst imaging live, it is necessary to first toggle off the ‘Continuous 

Auto Gain’ button.   The horizontal scroll bars can be used to manually adjust the displayed 

image’s sensitivity and range.    

The ‘Sensitivity’ number indicates how many degrees span the image from black (cold) to white 

(hot).  The range numbers represent the upper and lower values of temperature from black 

(cold) to white (hot). 

3.4.2.3 Menus 

Figure 9: Thermal Imager Tool Bar 

1. Take snapshot 

2. Edit emissivities 

3. Edit colour map 

4. Toggle temperature graph 

5. Toggle controls 

6. Continous auto gain 

7. Single auto gain 

8. Live display 

 1           2                  3            4              5            6              7            8
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The File menu allows the following: 

New – opens a new imager window, which may be set up to run under its own set of 

controls.

Open… – opens a previously stored image. 

Close – closes the current window. 

Save – saves the current window as a scene data file. 

Save As… – saves the current window as a new scene data file. 

MS Excel output… – saves data in CSV format from the temperature/time graph ready for 

use in a spreadsheet. Output of either the selected pixel(s) or all pixels can be saved to MS 

Excel at a suitable up date interval. 

Snapshot n – A list of previously saved snapshots. 

Exit – Exits program. 

The Edit menu allows the following: 

Copy (Ctrl C) – takes a copy of the image, it can then be pasted into another document e.g. 

MS Word. 

Copy to bitmap – copies image to a ‘.bmp’ file. 

Snapshot – takes a snapshot of the image and saves it as a scene data file. 

The View menu allows the following: 

Toolbar - Turn the Tool Bar on and off. 

Status Bar - Turn the Status Bar on and off. 

Control Panel - Turn the Control Panel on and off. 

Temperature Graph - Turn the Temperature Graph on and off. 

The Tools menu allows access to:

Emissivity editor – allows the editing of the emissivity tables. 

Colour map editor –allows the editing of the colour map editor. 

Edit Label – allows the editing of the labels for saving the images. 

The Window menu allows access to the running windows and allows the user to control how they are 

displayed.  The options available are: 

Cascade. – Cascades all open images 

Tile. – Displays all open images simultaneously. 

Arrange Icons. – arranges the Icons of minimised windows. 

The About menu displays information about the program, including the software version number. 

3.4.2.4 Producing a Temperature Graph (live imaging): 

Use the ‘temperature graph toggle’ on the Tool Bar, or select Temperature Graph from the 

View menu.  See Figure 9 for more information on the Tool Bar.   

The displayed window layout with temperature graph will look like Figure 10.

The time axis of the graph can be adjusted by selecting values from the “Temperature Graph 

time scale” function in the controls window. 
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Figure 10: Image display, control panel and temperature graph. 

1. Temperature graph 

2. Control panel 

The window may be re-sized to optimise viewing of the display and status display. 

Temperature measurement cursors can be added (and removed) from the image by “double clicking” 

the mouse cursor over the desired part of the image. Up to 10 cursors can be selected and each one is 

displayed in a different colour. To read the temperature of a cursor, use the mouse to click on the 

corresponding oval colour as displayed in the “temperature display window”, see Figure 10.  The 

temperature graph plots will also be displayed in the same colour as the selected cursors.

3.4.2.5 Use of PC software with no Thermal Imager connected 

The software may be used to examine stored snapshots without the imager connected.  When the 

program is launched, the image window should be closed.  From the File menu, select “Open” and a list 

of saved ‘.snp’ files will be available from the last folder saved to.      

Select the required ‘.snp’ file and the image will be presented in a window with all the status data from 

when the scene data was recorded.  The information in the image window may be manipulated as for 

live images, except that a temperature graph will not be available, integration of multiple images will 

not be possible and the continuous auto gain function is not required. 

1

2
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4 Operating notes and precautions 

4.1 Temperature measurement 

The following should be noted when using the instrument as a temperature indicator: 

1. The indicated temperature value is derived from a calibration obtained when the 

instrument is in a thermally stable environment.  If the instrument is not thermally 

stabilised, there may be an error in the indicated temperature.  Thermal stabilisation may 

take a few minutes – a period of 2 minutes or longer may be necessary.   

2. The calibrated temperature output is the figure in the temperature box; the temperature 

scale and display colours are indicators only. 

3. Caution should be observed in using the emissivity control – the user should explore the 

effect on the observed temperature of an object when different emissivities are selected.  

Figures associated with particular materials are supplied as a guide only. 

Low values of emissivity should be used only with extreme caution as large errors in 

temperature readings may be obtained with only small errors in emissivity. 

4. Only the central 12 x 12 elements should be used for temperature measurements.  The 

camera should be positioned so that the item of interest appears within this area of the 

display. 

Caution:  Do not adjust the lens focus.  The lens is fixed focus and factory set. 

4.2 General 

The lens and associated holder is not user adjustable. The focal point of the imager has been set at 

manufacture according to specification.  SKF will not be held responsible for any internal damage 

should this mount be altered.  Behind the lens is the accurately positioned chopper blade. 

4.3 Cleaning & Periodic Maintenance 

Only when necessary, clean the lens using a soft dry lint free cloth and isopropyl alcohol. The body of 

the imager can be cleaned using a moist cloth. Do not use solvents for cleaning. 

When in storage for more than a month, the batteries should be removed. 

4.4 Calibration 

One of the main costs in manufacture imagers is calibrating and specifying the accuracy of the imager.  

In order to reduce this cost, SKF have decided to concentrate on the application of predictive 

maintenance, where the primary requirement is to identify hot spots and get an indication of the 

temperature rise over ambient, or a comparative temperature rise with a similar component. With a 

sensitivity of ~0.3°C, the imager is suitable for this application allowing good detection of hot spots and 

temperature differences. Consequently SKF supply the imager without a defined accuracy. 
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For the SKF TMTI thermal imager, a more appropriate annual check is a conformity check.  This would 

involve a black body to check the instrument’s ability to distinguish temperature differences and a 

general operational check. 
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5 Specifications 

PERFORMANCE 

Temperature Measurement 

range: -10°C to +300°C 

Field of view (FOV): 20° x 20° 

Spectral Response: 8 to 14 micrometers 

Sensitivity: ~0.3K @ 30°C 

Displayed Image: 96 x 96 pixels 

Detector: 16 x 16 pixel array 

Frame rate: 8Hz 

IMAGE STORAGE 

Up to 1000 images per MB of Memory. 

LASER POINTER 

Class II laser  

IMAGER POWER SUPPLY 

Battery: 4 x AA (LR6) alkaline batteries. 

Operation time: Up to 8 hours. 

AC operation: AC adaptor, supplied. 

MECHANICAL 

Housing: Impact Resistant Plastic. 

Dimensions: 120mm x 125mm x 80mm. 

Weight: < 600g not including ‘Pocket PC’ and handle. 

Mounting: Handheld & Tripod mounting. 

TMTI 300 INCLUDES 

Imager, software for ‘Pocket PC’, & PC, iPaq type synchronization cable, 

2m RS232 connection cable - imager to PC, user 

manual, AC power supply, Tool case. 

ENVIRONMENT 

Temp. operating range: -5°C to +50°C Humidity: 10% to 90% non condensing 

Temp. storage range: -20°C to +80°C CE Mark (Europe): Complies with EMC directive 

IP Level 40 

COMPUTER REQUIREMENTS 

Pocket PC: Compatible with most ‘Pocket PC’ devices running Microsoft ‘Pocket PC’ 2000, 2002, 2003 

and MSWM 5. RS 232 to ‘Pocket PC’ communication cable or CompactFlash RS 232 adaptor where 

applicable. 

PC: IBM compatible running MS Windows XP or 2000, with an RS232 serial port, USB port and 24 bit 

colour graphics.   

All brands and product names are acknowledged and may be trademarks or registered trademarks of 

their respective holders. 
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In line with our policy of continuous development of our 

products we reserve the right to alter any part of the above 

specification without prior notice. 

Although care has been taken to ensure the accuracy of 

this publication, SKF does not assume any liability for 

errors or omissions. 

Conformement a notre politique de developpement continu 

de nos produits, nous nous reservons le droit de modifier, 

sans preavis, tout ou partie des specifications ci-dessus. 

Gemas unserer Firmenpolitik der standigen 

Weiterentwicklung unserer Produkte behalten wir uns 

Anderungen der obigen Daten ohne Vorankundigung vor. 

En linea con nuestra politica de constante desarrollo de 

nuestros productos, nos reservamos el derecho a modificar 

cualquier parte de las especificaciones sin previa 

notificacion. 

In linea con la nostra politica di sviluppo continuo dei 

prodotti ci riserviamo il diritto di apportare modifiche senza 

preavviso a qualsiasi parte della presente documentazione. 

I linje med var policy for kontinuerlig utveckling av vara 

produkter forbehaller vi oss ratten att andra ovanstaende 

specifikationer utan att meddela i forvag. 

In verband met onze politiek van continue ontwikkeling van 

onze produkten, behouden wij ons het recht voor om de 

specificaties van de vermelde onderdelen te wijzigen 

zonder nota vooraf. 

Em linha com a nossa politica de desenvolvimento 

continuo dos nossos produtos, reservamo-nos o direito de 

alterar este catalogo sem aviso previo. 

I overensstemmelse med vor politik for kontinuerlig 

udvikling af vore produkter forbeholder vi os ret til at andre 

pa hvilken som helst af de i brochuren navnte 

specifikationer, uden at meddele dette i forvejen. Desuden 

tages der forbehold for eventuelle trykfejl. 

Tavoitteenamme on tuotteidemme jatkuva kehittely. 

Pidatamme siksi oikeuden etukateen ilmoittamatta muuttaa 

ylla olevia erittelyja.

,

.

SKF Maintenance Products     

© Copyright SKF 2006/02

www.mapro.skf.com
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